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1. Importante

1. Importante

Questa guida all’uso elettronica è intesa 

per chiunque usi il monitor Philips. Leggere 

accuratamente questo manuale d’uso prima di 

usare il monitor. Contiene informazioni e note 

importanti sul funzionamento del monitor.

La garanzia Philips è valida a condizione che il 

prodotto sia usato in modo corretto e secondo le 

istruzioni fornite, dietro presentazione della fattura 

originale o dello scontrino di vendita, indicante la 

data d’acquisto, il nome del rivenditore, il modello 

e il numero di produzione del prodotto.

1.1 Manutenzione e precauzioni di sicurezza

 Avvertenze

L’utilizzo di dispositivi, registrazioni o procedure 

differenti da quelle specificate nelle presenti 

istruzioni possono esporre al rischio di corto 

circuito, rischi elettrici e/o rischi meccanici.

Leggere e seguire le presenti istruzioni durante il 

collegamento e l’utilizzo del monitor del computer.

Funzionamento

Posizionare il monitor lontano dalla luce diretta • 

del sole, fonti di illuminazione molto forti e 

da qualsiasi altra fonte di calore. L’esposizione 

prolungata a questo tipo di ambiente può 

causare perdita di colore e danni al monitor.

Rimuovere qualsiasi oggetto che potrebbe • 

cadere nei fori di ventilazione od ostacolare 

il corretto raffreddamento delle parti 

elettroniche del monitor. 

Non bloccare i fori di ventilazione sul cabinet.• 

Durante il posizionamento del monitor • 

assicurarsi che il connettore e la presa di 

alimentazione siano facilmente accessibili.

Se si spegne il monitor scollegando il cavo di • 

alimentazione o il cavetto in c.c., attendere 6 

secondi prima di reinserire il cavo o il cavetto 

in c.c. per il normale funzionamento.

Utilizzare sempre il cavo di alimentazione • 

approvato fornito da Philips. Se il cavo di 

alimentazione è assente, rivolgersi al centro 

di assistenza locale. (Vedere Customer Care 

Consumer Information Center) 

Non far subire al monitor forti vibrazioni o • 

impatti severi durante il funzionamento.

Non colpire né lasciare cadere il monitor • 

durante il funzionamento o il trasporto.

Manutenzione

Per proteggere il monitor da possibili danni, • 

non esercitare pressione eccessiva sul 

monitor. Se si sposta il monitor, afferrare il 

telaio per sollevare; non sollevare il monitor 

posizionando le mani e le dita sul monitor.

Se si prevede di non utilizzare il monitor • 

per lunghi periodi, scollegarlo dalla presa di 

corrente.

Se occorre pulire il monitor con un panno • 

leggermente umido, scollegare il monitor 

dalla presa di corrente. Lo schermo può 

essere asciugato con un panno asciutto 

quando l’alimentazione è scollegata. Tuttavia, 

non utilizzare solventi organici come alcool, 

oppure liquidi a base di ammoniaca per pulire 

il monitor.

Per evitare danni permanenti al set, non • 

esporre il monitor a polvere, pioggia, acqua o 

eccessiva umidità.

Se il monitor si bagna, strofinarlo con un • 

panno asciutto. 

Se sostanze estranee o acqua penetrano • 

nel monitor, disattivare immediatamente 

l’alimentazione e scollegare il cavo di 

alimentazione. Quindi, rimuovere la 

sostanza estranea oppure l’acqua e inviare 

immediatamente il monitor a un centro di 

assistenza.

Non immagazzinare o usare il monitor in • 

luoghi esposti al calore, alla luce diretta del 

sole, o freddo estremo.

Per conservare prestazioni ottimali del • 

monitor e utilizzarlo per un periodo 

prolungato, utilizzare il dispositivo in una 

postazione caratterizzata dalle seguenti 

condizioni ambientali: 

Temperatura: 0-40°C 32-95°F  ◦
Umidità: 20-80% RH  ◦
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1. Importante

Informazioni importanti per l’immagine Burn-in/

Ghost (immagine permanente)

Attivare sempre uno screen saver con • 

animazione quando si lascia il monitor 

inattivo. Attivare sempre un’applicazione 

d’aggiornamento periodico dello schermo 

se il monitor visualizzerà contenuti statici 

che non cambiano. La visualizzazione senza 

interruzioni di immagini statiche per un lungo 

periodo di tempo può provocare il fenomeno 

di “burn in”, anche noto come “persistenza 

dell’immagine” o “ghost”, sullo schermo. 

 Il ”Burn-in”, la ”persistenza delle immagini”, • 

o il ”ghost” sono tutti fenomeni noti nella 

tecnologia dei monitor. Nella maggior parte 

dei casi le immagini persistenti scompaiono 

gradualmente dopo un po’ di tempo, quando 

viene tolta l’alimentazione. 

 Avvertenze

La mancata attivazione dello screensaver o il 

periodico aggiornamento dello schermo possono 

causare la permanenza di immagini “burn-in” 

o “after-image” o “ghost” nel server che non 

possono essere riparate. Tali danni non sono 

coperti dalla garanzia.

Assistenza

La copertura dell’involucro del monitor • 

deve essere aperta esclusivamente da tecnici 

qualificati.

Se si ha necessità di documenti per riparazioni • 

o integrazioni, rivolgersi al centro di assistenza 

locale (vedere il capitolo "Consumer 

Information Center"). 

Fare riferimento alla sezione "Specifiche • 

tecniche" per informazioni sul trasporto. 

Non lasciare il monitor in una vettura/in un • 

autocarro esposto all’illuminazione solare 

diretta.

 Nota

Consultare un tecnico dell’assistenza se il monitor 

non funziona normalmente oppure se non si è 

sicuri di come procedere dopo avere seguito le 

istruzioni del presente manuale.

1.2 Avvertenze e legenda

La sezione che segue fornisce una descrizione 

di alcuni simboli convenzionalmente usati nel 

presente documento. 

Note, Attenzione e Avvertenze

Leggendo questa guida, incontrerete blocchi di 

testo accompagnati da specifiche icone e stampati 

in grassetto o corsivo. Tali parti contengono note, 

note di attenzione o di avvertenza. Segue un 

esempio d’uso:

 Nota

Questa icona indica informazioni e suggerimenti 

importanti che potrebbero risultare utili per un 

utilizzo ottimale del vostro computer.

 Attenzione

Questa icona segnala indicazioni per evitare la 

possibilità di danni al sistema o la perdita di dati.

 Avvertenze

Questa icona indica la possibilità di danni personali 

e segnala indicazioni per la prevenzione di detti 

problemi.

Alcune altre indicazioni di attenzione e avvertenza 

potrebbero presentarsi in formati diversi, e/o non 

essere accompagnati della relativa icona. In tali 

casi, la presentazione specifica delle varie note è 

conforme alle regolamentazioni locali.
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1.3 Smaltimento del prodotto e dei materiali 

d’imballaggio

Waste Electrical and Electronic Equipment-

WEEE

This marking on the product or on its packaging 

illustrates that, under European Directive 2002/96/

EC governing used electrical and electronic 

appliances, this product may not be disposed 

of with normal household waste. You are 

responsible for disposal of this equipment through 

a designated waste electrical and electronic 

equipment collection. To determine the locations 

for dropping off such waste electrical and 

electronic, contact your local government office, 

the waste disposal organization that serves your 

household or the store at which you purchased 

the product.

Your new monitor contains materials that can be 

recycled and reused. Specialized companies can 

recycle your product to increase the amount of 

reusable materials and to minimize the amount to 

be disposed of. 

All redundant packing material has been omitted. 

We have done our utmost to make the packaging 

easily separable into mono materials.

Please find out about the local regulations on how 

to dispose of your old monitor and packing from 

your sales representative. 

Recycling Information for Customers

Your display is manufactured with high quality 

materials and components which can be recycled 

and reused. 

To learn more about our recycling program please 

visit www.philips.com/about/sustainability/recycling.
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2. Impostazione del monitor

2. Impostazione del monitor

2.1 Installazione

 Contenuti della confezione

 Installazione della base

Collocare il monitor, a faccia in giù, su una 1. 

superficie liscia, prestando attenzione a non 

graffiare o danneggiare lo schermo.

Collegare la colonna della base al monitor 2. 

fino a bloccarla in posizione.

Tenere la base del monitor con entrambe 3. 

le mani ed inserire con fermezza la base nel 

supporto.
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2. Impostazione del monitor

 Collegamento al PC

 Ingresso potenza AC

 Ingresso VGA

  Ingresso DVI-D

 Sistema antifurto Kensington

Collegamento al PC

Collegare saldamente il cavo 1. 

d’alimentazione sul retro del monitor.

Spegnere il computer e staccare il cavo 2. 

d’alimentazione.

Collegare il cavo segnale del monitor al 3. 

connettore video sul retro del computer.

Collegare i cavi d’alimentazione del 4. 

computer e del monitor ad una presa di 

corrente nelle vicinanze.

Accendere il computer ed il monitor. 5. 

Se sul monitor appare un’immagine, 

l’installazione è riuscita.

2.2 Funzionamento del monitor

  Descrizione del pannello frontale del 

prodotto

5

6 27 14 3

Per accendere e spegnere il 

monitor. 

Per accedere al menu OSD.

Per tornare al livello precedente 

del menu OSD.

Per regolare il livello di luminosità.

Per regolare il menu OSD.

Per cambiare il formato di 

visualizzazione.

Regolare automaticamente il 

monitor.
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2. Impostazione del monitor

 Descrizione dei comandi OSD

Che cos’è il menu OSD (On-Screen Display)?

L’On-Screen Display (OSD) è una funzione 

presente su tutti i monitor Philips. Consente 

all’utente di regolare le prestazioni dello 

schermo o di selezionare le funzioni del monitor 

direttamente tramite una finestra di istruzioni a 

video. Di seguito è mostrata un’illustrazione della 

semplice interfaccia OSD:

Istruzioni semplici e di base sui tasti di controllo

Nel menu OSD mostrato in precedenza, premere 

il tasto   sul pannello frontale del monitor per 

spostare il cursore, premere OK per confermare 

la scelta o la modifica.

Il menu OSD

Di seguito c’è una descrizione generale della 

struttura del menu OSD. Questa può essere 

utilizzata come riferimento quando in seguito si 

lavorerà sulle diverse regolazioni.
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2. Impostazione del monitor

 Notifica di risoluzione

Questo monitor è progettato per rendere le 

prestazioni ottimali alla sua risoluzione originaria 

di 1366×768 a 60Hz. Quando il monitor è 

impostato su una risoluzione diversa, all’accensione 

è visualizzato un avviso: Usare la risoluzione 

1366×768 a 60Hz per ottenere le prestazioni 

migliori.

La visualizzazione dell’avviso può essere disattivata 

dal menu Setup (Configurazione) del menu OSD.

 Funzioni fisiche

Inclinazione

2.3 Rimozione del supporto e della base

 Rimozione della base

Prima di iniziare a smontare la base del monitor, 
osservare le istruzioni che seguono per evitare 
danni o lesioni.

 Collocare il monitor, a faccia in giù, su una 1. 

superficie liscia, prestando attenzione a non 

graffiare o danneggiare lo schermo.

2. Premere i fermagli di bloccaggio per rimuovere 

il supporto della base dalla colonna.

1

3. Premere il pulsante di rilascio per rimuovere la 

colonna della base.

2
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2. Impostazione del monitor

 Rimuovere la base

 È possibile utilizzare un giravite piatto da inserire 1. 

nei due fori di rilascio sul coperchio e premere 

delicatamente per rimuoverlo.

 Rimuovere le 4 viti e poi rimuovere la base dal 2. 

monitor.
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3. Informazioni sul prodotto

3.1 SmartContrast

 Che cos’è?

Tecnologia unica che analizza dinamicamente 

i contenuti visualizzati ed ottimizza 

automaticamente il rapporto di contrasto del 

monitor per la massima chiarezza e piacevolezza 

visiva, aumentando l’illuminazione per immagini più 

chiare, luminose e nitide oppure diminuendola per 

la visualizzazione di immagini chiare su sfondi scuri.

 Perché ne ho bisogno?

Vuoi la chiarezza ed il comfort visivo migliore per 

ogni tipo di contenuto. SmartContrast controlla 

dinamicamente il contrasto e regola l’illuminazione 

per immagini e videogiochi chiari, nitidi e luminosi, 

oppure per visualizzare testo chiaro e leggibile per 

i lavori d’ufficio. Riducendo il consumo energetico 

del monitor, si risparmia sui costi e si allunga la 

durata del monitor. 

 Come funziona?

Quando si attiva SmartContrast i contenuti 

visualizzati saranno analizzati in tempo reale 

per regolare i colori e controllare l’intensità 

dell’illuminazione. Questa funzione migliora il 

contrasto in modo dinamico per una grandiosa 

esperienza d’intrattenimento quando si guardano 

video o mentre si gioca.

3.2 Philips SmartControl Lite

Il nuovo software SmartControl Lite Phillips 

permette di controllare il monitor usando 

una semplice interfaccia grafica. Le regolazioni 

complicate appartengono al passato; questo 

software facile da usare guida durante le 

procedure per regolare con precisione la 

calibratura del colore, frequenza/fase, punto di 

bianco RGB, eccetera.

Dotato della tecnologia più avanzata in materia 

di algoritmi core per velocità d’elaborazione e 

risposta, questo software compatibile Windows 

7 dotato di attraenti icone animate è pronto per 

migliorare la tua esperienza con i monitor Philips!

 Installazione

Attenersi alle istruzioni e completare • 

l’installazione.

L’avvio si esegue ad installazione terminata.• 

Se si vuole avviare l’applicazione in un secondo • 

tempo, fare clic sul collegamento del desktop 

o nella barra degli strumenti.
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Procedura Wizard (guidata) primo avvio

La prima volta, dopo l’installazione di • 

SmartControl Lite, si passerà automaticamente 

alla procedura Wizard (guidata) primo avvio.

che guiderà passo a passo nel corso delle • 

procedure di regolazione delle prestazioni del 

monitor.

Per avviare la procedura guidata in un secondo • 

tempo, si può andare al menu Plug-in.

Usando il pannello Standard si possono • 

regolare altre opzioni senza ausilio della 

procedura guidata.

 Inizio con il pannello Standard:

Menu Adjust (Regolazione):

Il menu Adjust (Regolazione) permette di • 

regolare: Brightness (Luminosità), Contrast 

(Contrasto), Focus (Fuoco), Position (Posizio-

ne) e Resolution (Risoluzione).

Seguire le istruzioni ed eseguire la regolazione.• 

La voce Cancel (Annulla) chiede all’utente se • 

vuole annullare l’installazione.
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Menu Color (Colore):

Il menu Color (Colore) permette di regolare: • 

RGB, Black Level (Livello di nero), White Point 

(Punto bianco), Color Calibration (Calibratura 

colore) e SmartImage Lite (fare riferimento 

alla sezione SmartImage Lite).

Seguire le istruzioni ed eseguire la regolazione.• 

Fare riferimento alla tabella che segue per • 

informazioni dettagliate sulle voci dei menu 

secondari in base all’ingresso.

Esempio di Color Calibration (Calibratura • 

colore).
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"Show Me" (Mostrami) avvia il Tutorial della 1. 

calibratura colore.

Start (Avvia) – Avvia la sequenza di 6 fasi della 2. 

calibratura colore.

Quick View (Visione rapida) carica le immagini 3. 

prima/dopo.

Fare clic sul tasto Cancel (Annulla) per tornare 4. 

al pannello principale Color (Colore).

Enable color calibration (Abilita calibratura 5. 

colore) - Per impostazione predefinita questa 

opzione è attivata. Se è deselezionata, la 

calibratura colore non ha luogo ed i tasti Avvia 

e Visione rapida sono disabilitati.

La schermata della calibratura deve avere le 6. 

informazioni dei diritti esclusivi.

Prima schermata della calibratura colore:

Il tasto Previous (Precedente) è disabilitato • 

fino alla seconda schermata colore.

Il tasto Next (Avanti) va alla schermata • 

successiva (ci sono 6 schermate).

Il tasto Avanti dell’ultima schermata porta al • 

pannello File > Presets (Predefiniti).

Il tasto Cancel (Annulla) chiude l’interfaccia e • 

torna alla schermata Plug-in.



13

3. Informazioni sul prodotto

(Informazioni) ed Exit (Esci). Quando la voce 

Enable task tray menu (Abilita menu area 

di notifica) è disabilitata, l’icona dell’area di 

notifica visualizza solo EXIT (ESCI).

La voce Run at Startup (Esegui all’avvio) • 

è selezionata (attivata) per impostazione 

predefinita. Quando disabilitato, SmartControl 

Lite non si avvierà all’avvio, né sarà nell’area 

di notifica. Il solo modo per avviare 

SmartControl Lite è usare il collegamento sul 

desktop oppure il file del programma. Tutte le 

impostazioni configurate per essere eseguite 

all’avvio non si caricheranno quando questa 

casella è deselezionata (disabilitata).

Enable transparency mode (Abilita • 

trasparenza) (Windows 7, Vista, XP). 

L’impostazione predefinita è 0% Opaque (0% 

Opaco).

Options > Input (Opzioni > Ingresso) – Sarà 

attivo solo quando si seleziona Input (Ingresso) dal 

menu a discesa Options (Opzioni). Sugli schermi 

non supportati, con capacità DDC/CI, saranno 

disponibili solo le schede Help (Guida) e Options 

(Opzioni). Tutte le atre schede di SmartControl 

Lite non sono disponibili.

Visualizza il pannello Source instruction • 

(Istruzioni origine) e le impostazioni correnti 

dell’origine dell’ingresso.

Su schermi con un solo ingresso, questo • 

pannello non sarà visibile.

Options > Preferences (Opzioni > Preferenze) - 

Sarà attivo solo quando si seleziona Preferences 

(Preferenze) dal menu a discesa Options (Opzioni). 

Sugli schermi non supportati, con capacità DDC/

CI, saranno disponibili solo le schede Help (Guida) 

e Options (Opzioni).

Visualizza le impostazioni correnti delle • 

preferenze.

Una casella selezionata abilita la funzione. La • 

casella può essere selezionata e deselezionata.

La voce Enable Context Menu on desktop • 

(Abilita menu contestuale sul desktop) 

è selezionata (attivata) per impostazione 

predefinita. Enable Context Menu (Abilita 

menu contestuale) visualizza le opzioni di 

SmartControl Lite di Select Presets (Selezione 

predefiniti) e Tune Display (Regola schermo) 

del menu contestuale del desktop (clic tasto 

destro del mouse). Disabled (Disabilitato) 

rimuove SmartControl Lite dal menu 

contestuale.

La voce Enable Task Tray icon (Abilita icona • 

area di notifica) è selezionata (attivata) per 

impostazione predefinita. Enable Context 

Menu (Abilita menu contestuale) mostra il 

menu dell’area di notifica di SmartControl 

Lite. Facendo clic col tasto destro del mouse 

sull’icona nell’area di notifica, è visualizzato 

un menu di opzioni con le voci Help (Guida), 

Technical Support (Supporto tecnico), Check 

for Upgrade (Controlla aggiornamenti), About 
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Options > Audio (Opzioni > Audio) – Sarà attivo 

solo quando si seleziona Audio dal menu a discesa 

Options (Opzioni).

Sugli schermi non supportati, con capacità DDC/

CI, saranno disponibili solo le schede Help (Guida) 

e Options (Opzioni).

Help > User Manual (Guida > Manuale d’uso) – 

Sarà attivo solo quando si seleziona User Manual 

(Manuale d’uso) dal menu a discesa Help (Guida). 

Sugli schermi non supportati, con capacità DDC/

CI, saranno disponibili solo le schede Help (Guida) 

e Options (Opzioni).

Help > Version (Guida > Versione) - Sarà attivo 

solo quando si seleziona Version (Versione) 

dal menu a discesa Help (Guida). Sugli schermi 

non supportati, con capacità DDC/CI, saranno 

disponibili solo le schede Help (Guida) e Options 

(Opzioni).

Menu contestuale sensibile

Il Context Sensitive Menu (menu contestuale 

sensibile) è abilitato per impostazione predefinita. 

Se la voce Enable Context Menu (Abilita menu 

contestuale) è stata selezionata nel pannello 

Options > Preferences (Opzioni > Preferenze), il 

menu sarà visibile.

Il menu contestuale ha quattro voci:

SmartControl Lite - Quando selezionato, • 

è visualizzata la schermata About Screen 

(Informazioni sullo schermo).
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Select Preset (Selezione predefiniti) - • 

Fornisce un menu gerarchico di impostazioni 

predefinite salvate per l’uso immediato. 

Un segno di spunta mostra l’impostazione 

predefinita correntemente selezionata. Dal 

menu a discesa può essere richiamata la voce 

Valori predefiniti.

Tune Display (Regola schermo) - Apre il • 

pannello di controllo di SmartControl Lite.

SmartImage Lite – Controllo delle • 

impostazioni correnti, standard, Internet, Game 

(giochi).

Menu area di notifica abilitato

Il menu dell’area di notifica può essere visualizzato 

facendo clic col tasto destro del mouse sull’icona 

SmartControl Lite nell’area di notifica. Il clic col 

tasto sinistro del mouse avvierà l’applicazione.

L’area di notifica ha cinque voci:

Help (Guida) - Accesso al User Manual • 

(Manuale d’uso): Apre il file del User Manual 

(Manuale d’uso) usando il browser predefinito.

Technical Support (Supporto tecnico) - • 

Visualizza la pagina del Supporto tecnico.

Check for Update (Controlla aggiornamenti) - • 

Porta alla pagina PDI Landing e verifica la 

versione dell’utente con quella più recente 

disponibile.

About (Informazioni) - Visualizza informazioni • 

dettagliate di riferimento: versione del 

prodotto, informazioni sulla pubblicazione e 

nome del prodotto.

Exit (Esci) - Chiude SmartControl Lite.• 

Per eseguire di nuovo SmartControl Lite 

selezionare SmartControl Lite dal menu Program 

(Programmi), fare doppio clic sull’icona del 

desktop, oppure riavviare il sistema.

 

Menu area di notifica disabilitato

Quando l’area di notifica è disabilitata nella cartella 

delle preferenze, è disponibile solo la selezione 

EXIT (ESCI). Per rimuovere in modo completo 

SmartControl Lite dall’area di notifica, disabilitare 

la voce Run at Startup (Esegui all’avvio) in Options 

(Opzioni) > Preferences (Preferenze).
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4. Specifiche tecniche

4. Specifiche tecniche

Immagine/Schermo

Tipo di monitor LCD TFT

Illuminazione CCFL (196V3), LED (196V3L)

Dimensioni del pannello 18,5" (47,0 cm)

Rapporto proporzioni 16:9

Dimensioni pixel 0,3 x 0,3 mm

Luminosità 200 cd/m² (196V3), 250 cd/m² (196V3L)

SmartContrast 500.000:1 (196V3), 10.000.000:1 (196V3L)

Rapporto di contrasto (tipico) 700:1 (196V3), 1.000:1 (196V3L)

Tempo di risposta (tipico) 5 ms

Risoluzione ottimale 1366 x 768 a 60Hz

Angolo di visuale 90° (H) / 65° (V) a C/R>10 (196V3),

170° (H) / 160° (V) a C/R>10 (196V3L)

Colori dello schermo 16,7 milioni

Frequenza d'aggiornamento 

verticale

56Hz -76Hz

Frequenza orizzontale 30kHz - 83kHz

sRGB SÌ

Connettività

Ingresso segnale DVI-D (digitale), VGA (analogico)

Segnale d’ingresso Sincronia separata, Sync on Green

Utilità

Funzioni utili

Lingue OSD Inglese, Francese, Tedesco, Italiano, Russo, Spagnolo,  

Cinese Semplificato, Portoghese, Turco

Altre funzioni utili Sistema antifurto Kensington

Compatibilità Plug & Play DDC/CI, sRGB, Windows 7, Mac OSX, Linux 

Base

Inclinazione -5/+20 
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Alimentazione (196V3)

Acceso 19,3W (tipico), 20,81W (al massimo)

Consumo energetico 

(metodo di verifica  

EnergyStar 5.0)

Tensione ingresso AC 

a 100VAC +/-5VAC, 

50Hz +/- 5Hz

Tensione ingresso AC 

a 115VAC +/-5VAC, 

50Hz +/- 5Hz

Tensione ingresso AC 

a 230VAC +/-5VAC, 

50Hz +/- 5Hz

Funzionamento normale 

(tipico)

17,70W 17,52W 17,24W

Sospensione 0,5W 0,5W 0,5W

Spento 0,5W 0,5W 0,5W

Dissipazione di calore* Tensione ingresso AC 

a 100VAC +/-5VAC, 

50Hz +/- 5Hz

Tensione ingresso AC 

a 115VAC +/-5VAC, 

50Hz +/- 5Hz

Tensione ingresso AC 

a 230VAC +/-5VAC, 

50Hz +/- 5Hz

Funzionamento normale 60,41 BTU/hr 59,79 BTU/hr 58,82 BTU/hr 

Sospensione 1,706 BTU/hr 1,706 BTU/hr 1,706 BTU/hr

Spento 1,706 BTU/hr 1,706 BTU/hr 1,706 BTU/hr

Indicatore di alimentazione Modalità accensione: Bianco, Standby/ 

Sospensione: Bianco (lampeggiante)

Alimentazione Integrato, 100-240VAC, 50-60Hz

Alimentazione (196V3L)

Acceso 17,6W (tipico), 19,0W (al massimo)

Consumo energetico 

(metodo di verifica  

EnergyStar 5.0)

Tensione ingresso AC 

a 100VAC +/-5VAC, 

50Hz +/- 5Hz

Tensione ingresso AC 

a 115VAC +/-5VAC, 

50Hz +/- 5Hz

Tensione ingresso AC 

a 230VAC +/-5VAC, 

50Hz +/- 5Hz

Funzionamento normale 

(tipico)

14,15W 14,10W 14,10W

Sospensione 0,5W 0,5W 0,5W

Spento 0,5W 0,5W 0,5W

Dissipazione di calore* Tensione ingresso AC 

a 100VAC +/-5VAC, 

50Hz +/- 5Hz

Tensione ingresso AC 

a 115VAC +/-5VAC, 

50Hz +/- 5Hz

Tensione ingresso AC 

a 230VAC +/-5VAC, 

50Hz +/- 5Hz

Funzionamento normale 48,29 BTU/hr 48,12 BTU/hr 48,12 BTU/hr 

Sospensione 1,706 BTU/hr 1,706 BTU/hr 1,706 BTU/hr

Spento 1,706 BTU/hr 1,706 BTU/hr 1,706 BTU/hr

Indicatore di alimentazione Modalità accensione: Bianco, Standby/ 

Sospensione: Bianco (lampeggiante)

Alimentazione Integrato, 100-240VAC, 50-60Hz
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Dimensioni

Prodotto con base (LxHxP) 463 x 358 x 204 mm

Prodotto senza base (LxHxP) 463 x 294 x 44 mm

Peso

Prodotto con base 2,58 kg

Prodotto senza base 2,42 kg

Prodotto con la confezione 3,21 kg

Condizioni operative

Portata temperatura 

(operativa)
Da 0°C a 40°C

Portata temperatura (non 

operativa) 
Da -20°C a 60°C

Umidità relativa 20% a 80%

Altitudine
operativa: + 12.000 ft ( 3.658 m)

Non operativa: + 40.000 ft ( 12.192 m)

MTBF 30.000 ore

Ambiente

ROHS SÌ

EPEAT Argento (www.epeat.net)

EnergyStar 5.0 (solo per i modelli selettivi)

Confezione 100% riciclabile

Sostanze specifiche Scocca priva di PVC BFR

Conformità e standard

Approvazioni a norma di 

legge

CE Mark, FCC Class B, GOAST, SEMKO, TCO Certified (solo per i 

modelli selettivi), UL/cUL, BSMI, ISO9241-307, Energy star 5.0

Struttura

Colore Nero

Finitura Lucida/Superficie

 Nota

La certificazione EPEAT Gold o Silver è valida solo dove Philips registra il prodotto. Visitare il sito 1. 

www.epeat.net per conoscere lo stati della registrazione nel proprio paese.

Questi dati sono soggetti a cambiamenti senza preavviso. Andare all’indirizzo 2. www.philips.com/

support per scaricare la versione più recente del foglio informativo.
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4.1 Risoluzione e Modalità predefinite

 Risoluzione massima 

Per 196V3/196V3L

1366 x 768 a 60 Hz (ingresso analogico)

1366 x 768 a 60 Hz (ingresso digitale)

 Risoluzione raccomandata

Per 196V3/196V3L

1366 x 768 a 60 Hz (ingresso digitale)

Frequenza 

orizzontale 

(kHz)

Resolution 

(Risoluzione)

Frequenza 

verticale (Hz)

31,47 720x400 70,09 

31,47 640x480 59,94 

37,50 640x480 75,00 

37,88 800x600 60,32 

46,88 800x600 75,00

48,36 1024x768 60,00 

60,02 1024x768 75,03 

63,89 1280x1024 60,02 

79,98 1280x1024 75,03 

47,71 1366x768 59,79

 Nota 

Notare che lo schermo funziona meglio con la 

risoluzione nativa di 1366 x 768 a 60Hz. Per una 

qualità di visualizzazione migliore, seguire questi 

consigli sulla risoluzione.
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5. Risparmio energetico

5.1 Risparmio energetico automatico

Se la scheda video o il software installato sul PC 

è conforme agli standard DPM VESA, il monitor 

può ridurre automaticamente il suo consumo 

energetico quando non è in uso. Quando è 

rilevato l'input dalla tastiera, dal mouse o altri 

dispositivi, il monitor si "risveglia" automaticamente. 

La tabella che segue mostra il consumo energetico 

e le segnalazioni di questa funzione automatica di 

risparmio energetico:

196V3

Definizione del risparmio energetico

Modalità 

VESA

Video Sincronia 

orizzontale

Sincronia 

verticale

Potenza usata Colore del LED 

Attiva ATTIVO Sì Sì < 19,3 W 

(tipica)

Bianco

Sospensione  

(Standby)

DISATTIVO No No < 0,5 W 

(tipica)

Bianco 

(lampeggiante) 

Spegnimento DISATTIVO - - < 0,5 W 

(tipica)

DISATTIVO

196V3L

Definizione del risparmio energetico

Modalità 

VESA

Video Sincronia 

orizzontale

Sincronia 

verticale

Potenza usata Colore del LED 

Attiva ATTIVO Sì Sì < 17,6 W 

(tipica)

Bianco

Sospensione  

(Standby)

DISATTIVO No No < 0,5 W 

(tipica)

Bianco 

(lampeggiante) 

Spegnimento DISATTIVO - - < 0,5 W 

(tipica)

DISATTIVO

La configurazione che segue è usata per misurare 

il consumo energetico di questo monitor.

Risoluzione originale: 1366 x 768

Contrasto: 50%

Luminosità: 200 nit (196V3), 250 nit (196V3L)

Temperatura colore: 6500k con modello tutto bianco

 Nota

Questi dati sono soggetti a cambiamenti senza 

preavviso.
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6. Informazioni legali

Lead-free Product

Lead free display promotes 

environmentally sound recovery and 

disposal of waste from electrical and 

electronic equipment. Toxic substances 

like Lead has been eliminated and compliance with 

European community’s stringent RoHs directive 

mandating restrictions on hazardous substances 

in electrical and electronic equipment have been 

adhered to in order to make Philips monitors safe 

to use throughout its life cycle.

Congratulations, 

Your display is designed for both you and the 

planet!

The display you have just purchased 

carries the TCO Certified label. This 

ensures that your display is 

designed, manufactured and tested 

according to some of the strictest quality and 

environmental requirements in the world. This 

makes for a high performance product, designed 

with the user in focus that also minimizes the 

impact on the climate and our natural 

environment. 

TCO Certified is a third party verified program, 

where every product model is tested by an 

accredited impartial test laboratory. TCO Certified 

represents one of the toughest certifications for 

displays worldwide.

Some of the Usability features of the TCO 

Certified for displays:

 Visual ergonomics for good image quality is  •

tested to ensure top performance and reduce 

sight and strain problems. Important parameters 

are luminance, contrast, resolution, black level, 

gamma curve, colour and luminance uniformity 

and colour rendering 

 Products are tested according to rigorous safety  •

standards at impartial laboratories

 Electric and magnetic fields emissions as low as  •

normal household background levels

Low acoustic noise emissions (when applicable) •

Some of the Environmental features of the TCO 

Certified for displays:

 The brand owner demonstrates corporate  •

social responsibility and has a certified 

environmental management system (EMAS or 

ISO 14001)

 Very low energy consumption both in on- and  •

standby mode minimize climate impact

 Restrictions on chlorinated and brominated  •

flame retardants, plasticizers, plastics and heavy 

metals such as cadmium, mercury and lead 

(RoHS compliance)

 Both product and product packaging is prepared  •

for recycling

 The brand owner offers take-back options •

The requirements can be downloaded from our 

web site. The requirements included in this label 

have been developed by TCO Development in 

co-operation with scientists, experts, users as well 

as manufacturers all over the world. Since the end 

of the 1980s TCO has been involved in influencing 

the development of IT equipment in a more user-

friendly direction. Our labeling system started with 

displays in 1992 and is now requested by users 

and ITmanufacturers all over the world. About 

50% of all displays worldwide are TCO certified.

For more information, please visit

www.tcodevelopment.com

For displays with glossy bezels the user should 

consider the placement of the display as the bezel 

may cause disturbing reflections from surrounding 

light and bright surfaces.
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EPEAT 
(www.epeat.net)

“The EPEAT (Electronic Product 

Environmental Assessment Tool) 

program evaluates computer 

desktops, laptops, and monitors 

based on 51 environmental criteria developed 

through an extensive stakeholder consensus 

process supported by US EPA.

EPEAT system helps purchasers in the public 

and private sectors evaluate, compare and select 

desktop computers, notebooks and monitors 

based on their environmental attributes. EPEAT 

also provides a clear and consistent set of 

performance criteria for the design of products, 

and provides an opportunity for manufacturers to 

secure market recognition for efforts to reduce 

the environmental impact of its products.”

Benefits of EPEAT

Reduce use of primary materials

Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT’S 

requirement that all registered products meet 

ENERGY STAR’s energy efficiency specifications, 

means that these products will consume less 

energy throughout their life.

CE Declaration of Conformity

This product is in conformity with the following 

standards 

EN60950-1:2006 (Safety requirement of • 

Information Technology Equipment) 

EN55022:2006 (Radio Disturbance • 

requirement of Information Technology 

Equipment) 

EN55024:1998+A1:2001+A2:2003 (Immunity • 

requirement of Information Technology 

Equipment) 

EN61000-3-2:2006 (Limits for Harmonic • 

Current Emission) 

EN61000-3-3:1995+A1:2001+A2:2005 • 

(Limitation of Voltage Fluctuation and Flicker) 

following provisions of directives applicable

2006/95/EC (Low Voltage Directive) • 

2004/108/EC (EMC Directive) • 

2005/32/EC (EuP Directive, EC No. 1275/2008 • 

mplementing Directive for Standby and Off 

mode power consumption) and is produced 

by a manufacturing organization on ISO9000 

level.  

 The product also comply with the following 

standards 

ISO9241-307:2008 (Ergonomic requirement, • 

Analysis and compliance test methods for 

electronic visual displays)

GS EK1-2000:2009 (GS mark requirement)• 

prEN50279:1998 (Low Frequency Electric and • 

Magnetic fields for Visual Display) 

MPR-II (MPR:1990:8/1990:10 Low Frequency • 

Electric and Magnetic fields) 

 TCO certified (Requirement for Environment  •

Labeling of Ergonomics, Energy, Ecology and 

Emission, TCO: Swedish Confederation of 

Professional Employees) for TCO versions

Energy Star Declaration

(www.energystar.gov)

As an ENERGY STAR® Partner, we 

have determined that this product 

meets the ENERGY STAR® guidelines 

for energy efficiency.

 Note

We recommend you switch off the monitor when 

it is not in use for a long time.
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Federal Communications Commission (FCC) 

Notice (U.S. Only)

  This equipment has been tested and found 

to comply with the limits for a Class B digital 

device, pursuant to Part 15 of the FCC 

Rules. These limits are designed to provide 

reasonable protection against harmful 

interference in a residential installation. This 

equipment generates, uses and can radiate 

radio frequency energy and, if not installed 

and used in accordance with the instructions, 

may cause harmful interference to radio 

communications. However, there is no 

guarantee that interference will not occur 

in a particular installation. If this equipment 

does cause harmful interference to radio or 

television reception, which can be determined 

by turning the equipment off and on, the 

user is encouraged to try to correct the 

interference by one or more of the following 

measures:

Reorient or relocate the receiving antenna. • 

Increase the separation between the • 

equipment and receiver. 

Connect the equipment into an outlet on • 

a circuit different from that to which the 

receiver is connected. 

Consult the dealer or an experienced radio/• 

TV technician for help.

  Changes or modifications not expressly 

approved by the party responsible for 

compliance could void the user's authority to 

operate the equipment.

Use only RF shielded cable that was supplied with 

the monitor when connecting this monitor to a 

computer device. 

To prevent damage which may result in fire or 

shock hazard, do not expose this appliance to rain 

or excessive moisture. 

THIS CLASS B DIGITAL APPARATUS MEETS 

ALL REQUIREMENTS OF THE CANADIAN 

INTERFERENCE-CAUSING EQUIPMENT 

REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked 

with FCC Logo, 

United States Only

This device complies with Part 15 of the FCC 

Rules. Operation is subject to the following two 

conditions: (1) this device may not cause harmful 

interference, and (2) this device must accept any 

interference received, including interference that 

may cause undesired operation. 
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Commission Federale de la Communication 

(FCC Declaration)

  Cet équipement a été testé et déclaré 

conforme auxlimites des appareils numériques 

de class B,aux termes de l'article 15 Des 

règles de la FCC. Ces limites sont conçues 

de façon à fourir une protection raisonnable 

contre les interférences nuisibles dans le cadre 

d'une installation résidentielle. 

  CET appareil produit, utilise et peut émettre 

des hyperfréquences qui, si l'appareil n'est pas 

installé et utilisé selon les consignes données, 

peuvent causer des interférences nuisibles aux 

communications radio. 

  Cependant, rien ne peut garantir l'absence 

d'interférences dans le cadre d'une installation 

particulière. Si cet appareil est la cause 

d'interférences nuisibles pour la réception des 

signaux de radio ou de télévision, ce qui peut 

être décelé en fermant l'équipement, puis en 

le remettant en fonction, l'utilisateur pourrait 

essayer de corriger la situation en prenant les 

mesures suivantes:

Réorienter ou déplacer l'antenne de réception. • 

Augmenter la distance entre l'équipement et • 

le récepteur. 

Brancher l'équipement sur un autre circuit que • 

celui utilisé par le récepteur. 

Demander l'aide du marchand ou d'un • 

technicien chevronné en radio/télévision.

  Toutes modifications n'ayant pas reçu 

l'approbation des services compétents 

en matière de conformité est susceptible 

d'interdire à l'utilisateur l'usage du présent 

équipement.

N'utiliser que des câbles RF armés pour 

les connections avec des ordinateurs ou 

périphériques. 

CET APPAREIL NUMERIQUE DE LA CLASSE 

B RESPECTE TOUTES LES EXIGENCES DU 

REGLEMENT SUR LE MATERIEL BROUILLEUR 

DU CANADA. 

EN 55022 Compliance (Czech Republic Only)
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Polish Center for Testing and Certification 

Notice

The equipment should draw power from a socket 

with an attached protection circuit (a three-

prong socket). All equipment that works together 

(computer, monitor, printer, and so on) should 

have the same power supply source.

The phasing conductor of the room's electrical 

installation should have a reserve short-circuit 

protection device in the form of a fuse with a 

nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the 

power supply cable must be removed from the 

power supply socket, which should be located 

near the equipment and easily accessible.

A protection mark "B" confirms that the 

equipment is in compliance with the protection 

usage requirements of standards PN-93/T-42107 

and PN-89/E-06251.

North Europe (Nordic Countries) Information

Placering/Ventilation 

VARNING:

FÖRSÄKRA DIG OM ATT HUVUDBRYTARE 

OCH UTTAG ÄR LÄTÅTKOMLIGA, NÄR DU 

STÄLLER DIN UTRUSTNING PÅPLATS.

Placering/Ventilation 
ADVARSEL: 

SØRG VED PLACERINGEN FOR, AT 
NETLEDNINGENS STIK OG STIKKONTAKT ER 
NEMT TILGÆNGELIGE. 

Paikka/Ilmankierto 
VAROITUS: 

SIJOITA LAITE SITEN, ETTÄ VERKKOJOHTO 
VOIDAAN TARVITTAESSA HELPOSTI 
IRROTTAA PISTORASIASTA. 

Plassering/Ventilasjon 
ADVARSEL: 
NÅR DETTE UTSTYRET PLASSERES, MÅ 
DU PASSE PÅ AT KONTAKTENE FOR 
STØMTILFØRSEL ER LETTE Å NÅ.

BSMI Notice (Taiwan Only)
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Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht den 

in der "Verordnung über den Schutz vor Schäden 

durch Röntgenstrahlen" festgelegten Vorschriften. 

Auf der Rückwand des Gerätes befindet sich 

ein Aufkleber, der auf die Unbedenklichkeit der 

Inbetriebnahme hinweist, da die Vorschriften über 

die Bauart von Störstrahlern nach Anlage III ¤ 5 

Abs. 4 der Röntgenverordnung erfüllt sind. 

Damit Ihr Monitor immer den in der Zulassung 

geforderten Werten entspricht, ist darauf zu 

achten, daß 

Reparaturen nur durch Fachpersonal 1. 

durchgeführt werden. 

nur original-Ersatzteile verwendet werden. 2. 

bei Ersatz der Bildröhre nur eine bauartgleiche 3. 

eingebaut wird. 

Aus ergonomischen Gründen wird empfohlen, 
die Grundfarben Blau und Rot nicht auf dunklem 
Untergrund zu verwenden (schlechte Lesbarkeit 
und erhöhte Augenbelastung bei zu geringem 
Zeichenkontrast wären die Folge). 
Der arbeitsplatzbezogene Schalldruckpegel nach 
DIN 45 635 beträgt 70dB (A) oder weniger. 

ACHTUNG: BEIM AUFSTELLEN 
DIESES GERÄTES DARAUF 
ACHTEN, DAß NETZSTECKER UND 
NETZKABELANSCHLUß LEICHT 
ZUGÄNGLICH SIND. 

China RoHS 

The People's Republic of China released a 

regulation called "Management Methods for 

Controlling Pollution by Electronic Information 

Products" or commonly referred to as China 

RoHS. All products are produced and sold for 

China market have to meet China RoHS request.

 Note

Above regulation certificate might only be applied 

for selective models.
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Tipi di difetti dei pixel 

I difetti dei pixel e dei subpixel appaiono sullo 

schermo in modi diversi. Esistono due categorie di 

difetti dei pixel e diversi tipi di difetti dei subpixel 

all'interno di ogni categoria. 

Difetti da punti luminosi

Compaiono come pixel o subpixel sempre accesi 

oppure 'attivi'. Un punto luminoso è un sub-pixel 

che risulta evidenziato sullo schermo quando il 

monitor visualizza un motivo scuro. Esistono vari 

tipi di difetti da punti luminosi:

Un subpixel rosso, verde o blu illuminato

Due subpixel adiacenti illuminati:

- Rosso + Blu = Viola

- Rosso + Verde = Giallo

- Verde + Blu = Cyan (Blu Verdastro)

Tre subpixel adiacenti illuminati (un pixel bianco)

7. Assistenza Clienti e Garanzia

7.1  Politica dei difetti dei pixel per i monitor a 

schermo piatto della Philips

La Philips si impegna a consegnare prodotti della 

più alta qualità. Utilizziamo alcuni dei processi 

di produzione più avanzati nell'industria e delle 

rigorose procedure di controllo della qualità. Tuttavia 

i difetti dei pixel e dei subpixel nei monitor TFT 

usati nei monitor a schermo piatto sono talvolta 

inevitabili. Nessun produttore è in grado di garantire 

che tutti i pannelli siano privi di difetti dei pixel, ma 

la Philips garantisce che qualsiasi monitor con un 

numero inaccettabile di difetti sarà riparato oppure 

sostituito sotto garanzia. Questa nota spiega i diversi 

tipi di difetti dei pixel e definisce i livelli di difetto 

accettabili per ogni tipo. Per usufruire dell’offerta di 

riparazione o sostituzione sotto garanzia, il numero 

di difetti dei pixel su un monitor TFT deve superare 

i livelli descritti di seguito. Ad esempio: non più 

dello 0,0004% dei pixel secondari di un monitor 

può essere difettoso. Inoltre, siccome alcuni tipi o 

combinazioni di difetti dei pixel sono più evidenti 

di altri, per questi ultimi la Philips stabilisce degli 

standard di qualità più alti. Questa politica è valida in 

tutto il mondo.

Pixel e subpixel 

Un pixel, o elemento dell'immagine, è composto 

da tre subpixel nei tre colori fondamentali rosso, 

verde e blu. Molti pixel messi insieme formano 

un'immagine. Quando tutti i subpixel di un pixel 

sono illuminati, i tre subpixel colorati appaiono 

insieme come un singolo pixel bianco. Quando sono 

scuri, i tre subpixel colorati appaiono insieme come 

un pixel nero. Altre combinazioni di pixel illuminati 

o scuri appaiono come singoli pixel di altri colori.
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 Nota

Un punto luminoso rosso o blu deve essere oltre 

il 50 percento più luminoso dei punti adiacenti 

mentre un punto luminoso verde è il 30 percento 

più luminoso dei punti adiacenti.

Difetti da punti neri

Compaiono come pixel o subpixel sempre scuri 

o 'inattivi'. Un punto luminoso è un sub-pixel 

che risulta evidenziato sullo schermo quando il 

monitor visualizza un motivo scuro. Esistono vari 

tipi di difetti da punti neri:

DIFETTI DA PUNTI LUMINOSI LIVELLO DI ACCETTABILITA

1 subpixel accesi 3

2 subpixel adiacenti accesi 1

3 subpixel adiacenti accesi (un pixel bianco) 0

Distanza tra due difetti di punti luminosi* >15mm

Difettosità totale punti luminosi di tutti i tipi 3

DIFETTI DA PUNTI NERI LIVELLO DI ACCETTABILITA

1 subpixel scuri 5 o meno

2 subpixel scuri adiacenti 2 o meno

3 subpixel scuri adiacenti 0

Distanza tra due difetti relativi a punti neri* >15mm

Difettosità totale relativa a punti neri di ogni tipo 5 o meno

DIFETTOSITA TOTALE LIVELLO DI ACCETTABILITA

Difettosità totale relativa a punti luminosi o neri di ogni tipo 5 o meno

 Nota 

1 o 2 difetti su subpixel adiacenti = 1 punto difettoso

Questo monitor è conforme ISO9241-307. (ISO9241-307: Metodi di prova di ergonomia, di analisi e di 

conformità per visualizzatori elettronici)

Prossimità dei difetti dei pixel 

Poiché i difetti dei pixel e dei subpixel dello stesso 

tipo che si trovano vicini fra loro sono più evidenti, 

la Philips specifica pure gli elementi tollerabili per 

la prossimità dei difetti dei pixel.      

Elementi tollerabili nei difetti dei pixel

Per usufruire dell’offerta di riparazione o 

sostituzione a causa dei difetti dei pixel durante il 

periodo di garanzia, un pannello TFT in un monitor 

a schermo piatto Philips deve avere difetti dei 

pixel e dei subpixel che eccedono quelli tollerabili 

elencati nelle tabelle seguenti.
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7.2 Assistenza Clienti e Garanzia

Assistenza Clienti e Garanzia

Per informazioni sulla copertura della garanzia e sui requisiti aggiuntivi di assistenza validi per la vostra 

area, visitare il sito web www.philips.com/support. È inoltre possibile contattare il numero del vostro 

Philips Customer Care Center più vicino elencato in basso.

Informazioni di contatto per zona dell’EUROPA OCCIDENTALE:

Paese ASC Numero assistenza clienti Prezzo

Austria Siemens I&S +43 0810 000206 € 0.07

Belgium E Care +32 078 250851 € 0.06

Denmark A-novo +45 3525 8761 Local call tariff

Finland A-novo +358 09 2290 1908 Local call tariff

France A-novo +33 082161 1658 € 0.09

Germany Siemens I&S +49 01803 386 853 € 0.09

Greece Allman Hellas +30 00800 3122 1223 Free of charge

Ireland Invec Scotland +353 01 601 1161 Local call tariff

Italy A-novo +39 840 320 041 € 0.08

Luxembourg E Care +352 26 84 30 00 Local call tariff

Netherlands E Care +31 0900 0400 063 € 0.10

Norway A-novo +47 2270 8250 Local call tariff

Poland Zolter +48 0223491505 Local call tariff

Portugal Eatsa Spain +351 2 1359 1440 Local call tariff

Switzerland A-novo +41 02 2310 2116 Local call tariff

Spain Eatsa Spain +34 902 888 785 € 0.10

Sweden A-novo +46 08 632 0016 Local call tariff

United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff
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Informazioni di contatto per zona dell’EUROPA ORIENTALE E CENTRALE:

Paese Call center ASC Numero assistenza clienti

Belarus NA IBA +375 17 217 3386

Bulgaria NA LAN Service +359 2 960 2360

Croatia NA Renoprom +385 1 333 0974

Czech Rep. NA Asupport 800 100 697

Estonia NA FUJITSU +372 6519900

Hungary
NA Serware +36 1 2426331 

NA Profi Service +36 1 814 8080

Latvia NA “ServiceNet LV” Ltd. +371 7460399

Lithuania NA UAB "Servicenet" +370 7400088

Romania NA Blue Ridge Intl. +40 21 2101969

Russia
NA CPS +7 (495) 645 6746 (for repair)

NA CEEE Partners +7 (495) 645 3010 (for sales)

Serbia & 

Montenegro
NA Kim Tec d.o.o. +381 11 20 70 684

Slovakia NA Datalan Service +421 2 49207155

Slovenia NA PC H.and +386 1 530 08 24

Ukraine
NA Comel +380 562320045 

NA Topaz-Service Company +38 044 245 73 31

Turkey NA Techpro +90 212 444 4 832 

Informazioni di contatto per zona dell’AMERICA LATINA:

Paese Call center Numero assistenza clienti

Argentina Vermont 0800 3330 856

Brazil Vermont 0800-7254101

Informazioni di contatto per il NORD AMERICA:

Paese Call center ASC Numero assistenza clienti

Canada Supercom Supercom (800) 479-6696

U.S.A. TOS Teleplan (877) 835-1838

Informazioni di contatto per la Cina:

Cina

Numero Assistenza clienti: 4008 800 008



31

7. Assistenza Clienti e Garanzia

Informazioni di contatto per l'area APMEA:

Paese Call center ASC Numero assistenza clienti

Australia NA AGOS NETWORK PTY LTD 1300 360 386

Bangladesh NA
Distributor: Computer Source 

Ltd (warranty buy-out)

880-2-9141747, 9127592 

880-2-8128848 / 52

Cambodia NA

Distributor: Neat Technology 

Pte Ltd (Singapore) (warranty 

buy-out)

855-023-999992

Hong Kong / 

Macau
NA Smart Pixels Technology Ltd.

Hong Kong:Tel: +852 2619 9639 

Macau:Tel: (853)-0800-987

India NA REDINGTON INDIA LTD
Tel: 1 800 425 6396 

SMS: PHILIPS to 56677 

Indonesia NA PT. Gadingsari elektronika Prima
Tel: 62 21 75909053, 75909056, 

7511530

Israel NA Eastronics LTD 1-800-567000

Malaysia NA
After Market Solutions (CE) 

Sdn Bhd
603 7953 3370

Nepal NA
Distributor: Syakar Co. Ltd 

(warranty buy-out)
977-1-4222395 

New Zealand NA Visual Group Ltd. 0800 657447

Pakistan NA Philips Consumer Service (9221) 2737411-16

Philippines NA Glee Electronics, Inc. 
(02) 633-4533 to 34, 

(02) 637-6559 to 60

Singapore NA

Philips Electronics Singapore 

Pte Ltd (Philips Consumer Care 

Center)

(65) 6882 3999

South Africa NA Sylvara Technologies Pty Ltd 086 0000 888 

South Korea NA PCS One Korea Ltd. 080-600-6600

Sri Lanka NA
no distributor and/or service 

provider currently

Taiwan

PCCW 

Teleservices 

Taiwan 

FETEC.CO 0800-231-099

Thailand NA Axis Computer System Co., Ltd. (662) 934-5498

United Arab 

Emirates
NA AL SHAHD COMPUTER L.L.C 00971 4 2276525

Vietnam NA
FPT Service Informatic 

Company Ltd.

+84 8 38248007 Ho Chi Minh City 

+84 5113.562666 Danang City 

+84 5113.562666 Can tho Province
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8. Risoluzione dei problemi e 

FAQ

8.1 Risoluzione dei problemi

Questa pagina tratta i problemi che possono 

essere corretti dall’utente. Se il problema persiste, 

dopo avere tentato queste soluzioni, mettersi in 

contatto con il rappresentante del Servizio clienti 

Philips.

 Problemi comuni

Nessuna immagine (il LED d’alimentazione non è 

acceso)

Assicurarsi che il cavo d'alimentazione sia • 

collegato ad una presa di corrente ed alla 

presa sul retro del monitor. 

Per prima cosa, accertarsi che il tasto • 

d’alimentazione sul pannello frontale del 

monitor sia in posizione di spegnimento, 

poi premerlo per metterlo in posizione 

d’accensione.

Nessuna immagine (il LED d’alimentazione 

lampeggia di colore bianco)

Assicurarsi il computer sia acceso. • 

Assicurarsi che il cavo segnale sia collegato in • 

modo appropriato al computer. 

Assicurarsi che il cavo del monitor non abbia • 

pin piegati sul lato del collegamento. In caso 

affermativo, sostituire il cavo. 

Potrebbe essere stata attivata la funzione di • 

risparmio energetico.

Lo schermo visualizza il messaggio

Assicurarsi che il cavo del monitor sia • 

collegato in modo appropriato al computer. 

(Fare riferimento anche alla Guida rapida) 

Assicurarsi che il cavo del monitor non abbia • 

pin piegati. 

 Assicurarsi il computer sia acceso. • 

Il tasto AUTO non funziona

La funzione Auto è applicabile solo in • 

modalità VGA analogico. Se il risultato non 

è soddisfacente, si possono eseguire le 

regolazioni manuali usando il menu OSD. 

 Nota 

La funzione Auto non è applicabile in modalità 

DVI digitale perché non è necessaria. 

Sono presenti segni visibili di fumo o scintille

Non eseguire alcuna delle procedure di • 

risoluzione dei problemi

Scollegare immediatamente il monitor dalla • 

presa di corrente per motivi di sicurezza

Chiamare immediatamente un rappresentante • 

del Centro assistenza Philips.

 Problemi dell’immagine

Immagine non è centrata

Regolare la posizione dell’immagine usando la • 

funzione “Auto” dei controlli OSD. 

Regolare la posizione dell’immagine usando la • 

voce Fase/Regolazione del menu Impostazione. 

È valido solo in modalità VGA. 

L’immagine vibra sullo schermo

Controllare che il cavo segnale sia collegato in • 

modo appropriato alla scheda video del PC. 

Appare uno sfarfallio verticale

Regolare la posizione dell’immagine usando la • 

funzione “Auto” dei controlli OSD. 

Eliminare le barre orizzontali usando la voce • 

Fase/Regolazione del menu Impostazione.  

È valido solo in modalità VGA.
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Appare uno sfarfallio orrizontale

Regolare la posizione dell’immagine usando la • 

funzione “Auto” dei controlli OSD. 

Eliminare le barre orizzontali usando la voce • 

Fase/Regolazione del menu Impostazione.  

È valido solo in modalità VGA.

L’immagine appare sfuocata, indistinta o troppo 

scura

Regolare il contrasto e la luminosità usando il • 

menu OSD.

Dopo avere spento il monitor, rimane una 

"immagine residua", "immagine fantasma" o 

"Burn-in"

La visualizzazione senza interruzioni di • 

immagini statiche per un lungo periodo 

di tempo può provocare il fenomeno di 

“burn in”, anche noto come “persistenza 

dell'immagine” o “ghost”, sullo schermo. Il 

“Burn-in”, la “persistenza delle immagini”, 

o il “ghost” sono tutti fenomeni noti nella 

tecnologia dei monitor. Nella maggior parte 

dei casi le immagini persistenti scompaiono 

gradualmente dopo un po’ di tempo, quando 

viene tolta l’alimentazione. 

Attivare sempre uno screen saver con • 

animazione quando si lascia il monitor inattivo. 

Attivare sempre un’applicazione per • 

l’aggiornamento periodico dello schermo se il 

monitor presenta immagini statiche che non 

cambiano.

I casi più gravi di ” burn-in” o“persistenza delle • 

immagini” o di “ghost” non scompaiono e non 

possono essere risolti. Tali danni non sono 

coperti dalla garanzia.

L'immagine appare distorta. Il testo è indistinto o 

sfuocato

Impostare la risoluzione schermo del PC sulla • 

stessa risoluzione originale raccomandata per 

il monitor. 

Sullo schermo appaiono dei punti verdi, rossi, blu, 

scuri e bianchi

I punti residui sono una caratteristica normale • 

dei cristalli liquidi usato dalla tecnologia 

moderna. 

La luce d’"accensione" è troppo forte e disturba 
La luce del LED d’accensione può essere • 

regolata usando il menu Impostazione.

Per ulteriore assistenza, fare riferimento all’elenco 

Centri Informazioni consumatori e rivolgersi ad un 

rappresentante del Servizio clienti Philips.
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8.2 FAQ SmartControl Lite

Domanda 1. Ho cambiato il monitor da un PC 

ad uno diverso e SmartControl 

Lite è inutilizzabile, che cosa devo 

fare?

Risposta: Riavviare il PC e controllare 

se SmartControl Lite funziona. 

Diversamente, sarà necessario 

rimuovere ed installare di nuovo 

SmartControl Lite per assicurarsi 

che sia installato il driver corretto.

Domanda 2. SmartControl Lite prima 

funzionava bene, ma adesso non 

funziona più; che cosa devo fare?

Risposta: Se sono state eseguite le azioni 

che seguono, potrebbe essere 

necessario installare di nuovo il 

driver del monitor.

La scheda video è stata cambiata • 

Il driver video è stato aggiornato • 

Attività del sistema operativo, • 

come Patch o Service Pack 

Aggiornamento automatico di • 

Windows e aggiornamento del 

driver monitor e/o video 

Windows si è avviato col monitor • 

spento o scollegato. 

Per capire, fare clic col tasto 

destro del mouse su Risorse del 

computer e fare clic su  

Proprietà -> Hardware -> 

Gestione periferiche.  

Se si vede "Monitor Plug and 

Play" sotto Monitor, è necessario 

eseguire di nuovo l’installazione. 

Rimuovere ed installare di nuovo 

SmartControl Lite.

Domanda 3. Dopo avere installato 

SmartControl Lite, quando faccio 

clic sulla scheda SmartControl Lite 

non appare nulla, oppure appare 

un messaggio d’errore; che cosa è 

successo?

Risposta: Probabilmente la scheda grafica non 

è compatibile con SmartControl 

Lite. Se la scheda video è di una 

delle marche dette in precedenza, 

provare a scaricare il driver più 

aggiornato dal sito web dell’azienda 

produttrice. Installare il driver. 

Rimuovere ed installare di nuovo 

SmartControl Lite.

 Se ancora non funziona, siamo 

spiacenti di informare che la scheda 

video non è supportata. Visitare il 

sito Philips e controllare se sono 

disponibili driver aggiornati di 

SmartControl Lite.

Domanda 4. Quando faccio clic su Product 

Information (Informazioni sul 

prodotto) è mostrata solo parte 

delle informazioni; che cosa è 

successo?

Risposta: La scheda video o il driver potrebbe 

non essere della versione più 

recente che supporta in modo 

completo l’interfaccia DDC/CI. 

Provare a scaricare il driver più 

aggiornato della scheda video dal 

sito web dell’azienda produttrice. 

Installare il driver. Rimuovere ed 

installare di nuovo SmartControl 

Lite.
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Domanda 5. Domanda 5.Mi sono dimenticato il 

mio PIN per la funzione antifurto. 

Che cosa posso fare?

Risposta: Il Centro assistenza Philips ha il 

diritto di chiedere un’identificazione 

ed un’autorizzazione legittima per 

stabilire la proprietà del monitor.

 Notare che la funzione anti 

furto è offerta gratuitamente. 

La gestione dei numeri PIN è la 

sola responsabilità dell’utente o 

dell’organizzazione che li imposta.

 Nel caso venga dimenticato il 

numero PIN, il centro assistenza 

Philips è in grado di reimpostarlo 

con un costo nominale per l’utente 

dopo aver verificato il diritto di 

proprietà. Notare che questa 

attività non è coperta dalla garanzia 

standard.



36

8. Risoluzione dei problemi e FAQ

8.3 Domande generiche

Domanda 1: Quando installo il mio monitor, 

che cosa devo fare se lo schermo 

visualizza il messaggio “Cannot 

display this video mode” 

(Impossibile visualizzare questa 

modalità video)?

Risposta: Risoluzione raccomandata per 

questo monitor: 1366 x 768 a 

60Hz.

Scollegare tutti i cavi, poi • 

collegare il PC al monitor usato 

in precedenza. 

Aprire il menu Start di Windows • 

e selezionare Impostazioni/

Panello di controllo. Nella 

finestra del Pannello di controllo 

selezionare l’icona Schermo. 

Nella finestra Proprietà - 

Schermo, selezionare la 

scheda “Impostazioni”. Nella 

scheda Impostazioni, nell’area 

denominata “Risoluzione dello 

schermo”, spostare il dispositivo 

di scorrimento su 1366 x 768 

pixel. 

Aprire le “Proprietà Avanzate” • 

ed impostare la Frequenza di 

aggiornamento su 60Hz, poi fare 

clic su OK. 

Riavviare il computer e ripetere • 

le istruzioni dei punti 2 e 3 per 

verificare che il PC sia impostato 

su 1366 x 768 a 60Hz. 

Spegnere il computer, scollegare • 

il vecchio monitor e ricollegare il 

monitor Philips. 

Accendere il monitor e poi • 

accendere il PC.

Domanda 2: Qual è la frequenza 

d’aggiornamento raccomandata 

per il monitor?

Risposta: La frequenza d’aggiornamento 

raccomandata per il monitor 

è 60Hz. Nel caso ci siano dei 

disturbi sullo schermo, la frequenza 

d’aggiornamento può essere 

regolata su un valore massimo di 

75Hz per cercare di risolvere il 

problema. 

Domanda 3: Che cosa sono i file .inf e .icm del 

CD-ROM? Come si installano i 

driver (.inf e .icm)?

Risposta: Questi sono i file driver del monitor. 

Seguire le istruzioni del Manuale 

d’uso per installare i driver. La prima 

volta che si installa il monitor, il 

computer potrebbe richiedere i 

driver del monitor (file .inf e .icm ) 

oppure il disco del driver. Seguire 

le istruzioni per inserire il (CD-

ROM in dotazione) incluso nella 

confezione. I driver del monitor 

(file .inf e .icm) saranno installati 

automaticamente.

Domanda 4: Come si regola la risoluzione?

Risposta: La scheda video / il driver video ed 

il monitor determinano insieme le 

risoluzioni disponibili. La risoluzione 

preferita si seleziona nel Pannello 

di controllo Windows® usando le 

“Proprietà - Schermo”.

Domanda 5: Che cosa faccio se mi perdo 

durante le procedure di 

regolazione del monitor?

Risposta: Semplicemente: premere il tasto 

OK e poi selezionare “Ripristina” 

per richiamare tutte le impostazioni 

predefinite.
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Domanda 6: Il monitor è resistente ai graffi?

Risposta: In generale si raccomanda di 

sottoporre la superficie del pannello 

ad impatti e di proteggerla da 

oggetti dalla forma appuntita o 

arrotondata. Quando si maneggia 

il monitor, assicurarsi di applicare 

pressioni alla superficie del pannello. 

Diversamente le condizioni della 

garanzia potrebbero essere 

modificate.

Domanda 7: Come si pulisce la superficie del 

monitor?

Risposta: Usare un panno pulito, morbido 

e asciutto per la pulizia normale. 

Usare alcool isopropilico per una 

pulizia più accurata. Non usare altri 

solventi come alcool etilico, etanolo, 

acetone, esano, eccetera.

Domanda 8: Posso modificare l'impostazione 

colore del monitor?

Risposta: Sì, le impostazioni colore possono 

essere cambiate usando, come 

segue, i comandi OSD,

Premere "OK" per visualizzare il • 

menu OSD (On Screen Display)

Premere la "Freccia giù" per • 

selezionare l'opzione "Colore" 

e poi premere il tasto "OK" per 

accedere alle impostazioni colore; 

ci sono tre impostazioni, come 

segue.

Temperatura colore.  1. 

Le 2 impostazioni sono 6500K 

e 9300K.

sRGB; è l'impostazione 2. 

standard per assicurare il 

corretto scambio di colori tra 

i vari dispositivi (e.g. video/

fotocamere digitali, monitor, 

stampanti, scanner, eccetera). 

Definito dall'utente; si possono 3. 

scegliere le impostazioni 

preferite del colore regolando 

rosso, verde e blu.

 Nota

 Una misurazione del colore della luce irradiato 

da un oggetto mentre è riscaldato. Questa 

misurazione è espressa in termini di scala assoluta 

(gradi Kelvin). Temperature Kelvin basse, come 

2004K, sono i rossi; temperature più alte - come 

9300K - sono i blu. La temperatura neutra è il 

bianco, a 6504K.

Domanda 9: Posso collegare il mio monitor ad 

un PC, postazione di lavoro o Mac?

Risposta: Sì. Tutti i monitor Philips sono 

completamente compatibili con PC, 

Mac e postazioni di lavoro standard. 

Potrebbe essere necessario un 

cavo adattatore per collegare il 

monitor al sistema Mac. Rivolgersi 

al rivenditore Philips per altre 

informazioni. 

Domanda 10: I monitor Philips sono Plug-and-

Play?

Risposta: Sì, i monitor sono compatibili Plug-

and-Play con Windows 7, Vista, XP, 

NT, Mac OSX e Linux.
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Domanda 11: Che cos’è il fenomeno chiamato 

Image Sticking, o Image Burn-in, 

o immagine residua, o immagine 

fantasma dei monitor? 

Risposta: La visualizzazione senza interruzioni 

di immagini statiche per un lungo 

periodo di tempo può provocare il 

fenomeno di “burn in”, anche noto 

come “persistenza dell'immagine” 

o “ghost”, sullo schermo. Il “Burn-

in”, la “persistenza delle immagini”, 

o il “ghost” sono tutti fenomeni noti 

nella tecnologia dei monitor. Nella 

maggior parte dei casi il  

fenomeno "Burn-in", "immagine 

residua" o "immagine fantasma" 

scompare gradatamente nel tempo 

dopo che il monitor è stato spento.

 Attivare sempre uno screen saver 

con animazione quando si lascia il 

monitor inattivo.

 Attivare sempre un’applicazione 

per l’aggiornamento periodico 

dello schermo se il monitor 

presenta immagini statiche che non 

cambiano.

 Avvertenze

Fenomeni gravi di "Burn-in", "immagine residua" 

o "immagine fantasma" non spariranno e non 

possono essere riparati. Tali danni non sono 

coperti dalla garanzia.

Domanda 12: Perché lo schermo non visualizza il 

testo in modo nitido e mostra dei 

caratteri frastagliati?

Risposta: Il monitor lavora meglio con la 

risoluzione originale di 1366 x 768 a 

60Hz. Usare questa risoluzione per 

ottenere la visualizzazione migliore.
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